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About Panel Builder 
The CAP Panel Builder technology is designed to construct and manage panel configurations. These 
configurations often include frames, stacking frames, and tiles. However, depending on the catalog in 
use, Panel Builder can also be used to create field cut panels of custom width, floor-to-ceiling 
configurations with optioned heights and other manufacturer-specific design needs. 

Panel Builder allows designers to easily and accurately specify panels, space plan with those panels, and 
apply changes to some or all of the panels placed within a drawing. It does all of this in a part number 
independent environment. Panel Builder allows designers to space plan naturally, all the while 
maintaining an accurate Bill of Materials behind the scenes. 

Panel Builder eliminates the need to navigate complex catalog hierarchies to find a desired base panel 
and (when needed) stacking panel. Based on user selections of panel properties, Panel Builder validates 
and constructs the required style numbers and options as panel configurations. You save finished 
configurations under a user-defined name in a custom catalog, much like a CAP Standard. These 
configurations then behave as one finished assembly rather than many individual elements. 

Since all available widths of the stack configuration are automatically generated in the custom catalog, 
you can use these configurations to drag and drop stacked panels from the Explorer pane into a 
drawing. Or, use your stored configuration to replace or update any set of panel configurations already 
placed. 

Note: Since Panel Builder is an application shared across shared across multiple manufacturer product 
lines, there will be some functionality that will not apply to every manufacturer. 
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Hints and procedures 
As in other Windows applications, there are many ways to do specific tasks in 2020 Panel Builder. You 
can: 

 Use the menu bar to select the command 

 Click on an icon on the toolbar 

 Right-click to access the context menu 

Instead of showing different ways of performing the same task, procedures in this help file show you 
only one way so that you can quickly learn how to use the application. 

Note:  Make sure all Panel Builder toolbars are displayed for procedures directing you to click icons. 

Using Help 
Welcome to the 2020 CAP Panel Builder online help! The following section describes how to use options 
from the Help menu. Help is a way of quickly finding information or an explanation concerning an 
aspect of the 2020 CAP Panel Builder program. 

See also: 

 What's new 

 Online updates 

 Diagnostics 

 Software version (About CAP Studio) 
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What's new 

From the Help menu, click What’s New. From this window you can: 

 view announcements on 2020 Technologies commercial software 

 read about and download manufacturer catalog updates 

 view information about new commands, software fixes and known issues 

 download software updates 

 download PDF versions of the 2020 Technologies commercial software user guides 

 find training courses for 2020 Technologies software 

 view a list of upcoming industry events in which 2020 Technologies will participate 

 obtain 2020 Technologies' contact information 

Online updates 

Software and manufacturer catalog updates are often posted to the 2020 Website before they are 
available on DVD. 

To access updates online: 

1. From the Help menu select www.2020spaces.com. 

2. Select the category you need more information on. 

 See also: What's new 

http://www.2020spaces.com/
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Diagnostics 

The Diagnostics command from the Help menu is used by technical support to troubleshoot 2020 
software. 

Software version (About CAP Studio) 

To verify your version number, choose Help, About CAP Studio. 

Launch Panel Builder 
From the CAP Designer toolbar, click the Panel Builder icon. 

 

From the CAP Designer Automation Center 

1. Click the Automation Center  icon. 
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2. Click the desired manufacturer’s tab on the side of the Automation Tools pane. 
 

 
3. Select the product line you want work with with from the dropdown list. 

4. Click Start Panel Builder. 
 
See: 
Panel Builder interface 
Create a panel configuration 
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Note: While Panel Builder is usually run from CAP Designer, it is a standalone application and does not 
require any other software to be running. 

Panel Builder interface 
Upon first launch, Panel Builder appears as shown above and consists of: 

 Content pane - provides access to the components that can be placed in the panel configuration 

 Properties pane - allows changes to the characteristics of each component 

 Panel Configuration pane - area where you build the panel configuration 

 Menu bar - lists the tasks you can do in 2020 CAP Panel Builder 

 Toolbars - allows you to perform various operations quickly 

 Caption bar - displays the total height of the stack assembly 

 Status bar - shows a description when you hover the mouse pointer over a toolbar icon or a 
menu command 

The Content and Properties panes are moveable and can be docked in different locations. You can also 
auto-hide them. 
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Content pane 

The Content Pane is where you select elements to build a panel configuration. Element is the term for 
any item found in the Content pane. Depending on the catalog, elements include base panels, stacking 
panels, tiles, doors, base raceway covers and other parts needed to completely specify a Panel Builder 
configuration. 

Much of the layout of the Content Pane depends on the nature of the catalog; a catalog that does not 
have doors does not have a folder for doors. A Panel Builder catalog can have as many or as few folders 
and folder levels as the manufacturer decides. 

The Content Pane in Panel Builder is separate from the Content tab in CAP Explorer. It is designed to 
present the available elements in a logical and intuitive manner. At the bottom level of the navigation 
path of the Content Pane are the actual class instances (elements) that can be placed into the Panel 
Configuration Pane. 
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Panel configuration pane 

Once you select an element in the Content Pane, you place (drag and drop) it into the Panel 
Configuration Pane. If the class instance is a panel, that panel is placed. If it is a tile, it is placed at the 
location on the panel it is dropped on. 

For each Panel Builder catalog, rules exist to prevent illegal configurations. In the example below, a base 
panel has been placed and the user is attempting to place an illegal stacking panel above it. Panel 
Builder issues a Design Alert (highlighted in red below) to prevent the illegal configuration. 
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The Configuration Pane can have underlying rules that prevent almost any illegal configuration: 

 Rules that control the location, type, or number of tiles allowed on panel. 

 Rules to prevent certain tiles in certain locations based on the type of stacking panel in the 
configuration. 

 Rules that control the number or type of stacking frames. 

In addition to the catalog specific rules exampled above, the Configuration Pane has some fundamental 
rules built into its user interface. Rules like "tiles cannot overlap or extend beyond the top of the frame" 
and "stackers cannot be placed inside base frames" are built-in. 

Properties pane 

Once you place an item into the Panel Configuration pane, all of its available properties are displayed in 
the Properties Pane. 

 

Notice that you need to know nothing about the underlying structure of the electronic catalog. If 
changing a panel changes its part number, Panel Builder does it automatically behind the scenes. If the 
change requires a change to the options of the panel, Panel Builder handles that as well. In either case, 
it is transparent; you simply select the property you wish to apply, without the need for searching 
though the table of contents for a different part or diving into the details of option trails. 
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In addition to being able to change part numbers and options, a property can also add additional parts 
to the configuration. 

Properties can be dependent on other property choices. For example, if a panel only has three Raceway 
Cover options when it is Non-Powered but has nine when it is powered, Panel Builder will correctly 
support this. 

Move or dock the Content or Properties pane 

To customize the Panel Builder screen, you can drag the Content or Properties pane to various 
locations. 

Example - move the Properties pane: 

1. Hold down the left mouse button while the cursor is positioned over the Properties pane's title 
bar. 

2. Drag the Properties pane so that it is hovering over the Content pane area, then hover over the 
docking arrows that appear as shown below: 
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3. As displayed above, hovering over the arrows displays a shaded area where the pane will 

dock.  Release the mouse button when the desired area is shaded to re-dock the pane at the 
new location: 
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See also: Auto-hide the Content or Properties pane 
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Auto-hide the Content or Properties pane 

Another way to customize the Panel Builder screen is to auto-hide the Content or Properties pane so 
that is only displayed when you need to use it. 

Example- hide the Properties pane: 

1. Click the Auto Hide icon on the toolbar. 
 

 
 
Notice that the Properties pane is hidden, but you can still see its title bar beside the Content 
pane: 
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2. If you want to access the Properties pane simply hover over its title bar to display it. 
 

 

Menu bar 

Located on top of the 2020 CAP Panel Builder screen are menu names . They list the tasks you can do in 
2020 CAP Panel Builder. 

 

Click a menu to open it. 

Underlined letters in menu and command names indicate they can be accessed through a shortcut. 
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For example, to quickly open the File menu: 

1. Press ALT+F to open the File menu. 

2. Type in a letter corresponding to the underlined letter of the command you need. For instance, 
type the letter “S” to save. 
 
Some commands have even quicker shortcuts. Instead of opening menus, you can directly 
access a command by pressing CTRL plus a letter. For example, CTRL + letter “O” displays the 
Open dialog. 

To quickly find the help topics and shortcuts that correspond to each menu item, see the following 
under Command reference: 

 File menu 

 Edit menu 

 View menu 

 Tools menu 

 Help menu 

Toolbars 

As in standard Windows applications, toolbars in CAP Panel Builder allow you to perform frequent 
operations quickly with icons (images representing an action or a command). 
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You can easily customize toolbars. See the topics below for more information: 

 Show or hide a toolbar 

 Move a toolbar 

 Add and remove buttons 

The following toolbars are available in Panel Builder, each representing a category of commands: 

 Standard toolbar 

 Panel Width toolbar 

Show or hide a toolbar 

1. From the View menu, select Toolbars. 

2. Select the toolbar name to toggle the toolbar on and off. 
 

If it is off (no  next to the name), click it and the toolbar will appear on your screen (a  
will also appear next to its name). Selecting it again will turn it off. 

Move a toolbar 

A toolbar can be docked or floating. It is docked when no title bar appears and dots area available on 
the left side. 

Example of a docked toolbar: 

 



17 

Example of a floating toolbar: 

 

 To undock a toolbar and leave it floating, click-hold the mouse button on the dots on the left 

side of the toolbar  , move the toolbar and then release the mouse button. 

 To dock a floating toolbar, click- hold the mouse button on the title bar, move the toolbar to the 
desired spot and then release the mouse button. 

 To remove a floating toolbar from the screen, click the x in the title bar; to remove a docked 
one, use View, Toolbars. 

Add and remove buttons 

Customizing a toolbar consists of adding buttons to a built-in toolbar. 

1. Click on View, Toolbars, Customize. 

2. Click the Commands tab in the Customize dialog. 

3. To remove a button from a toolbar, click the button then drop it anywhere off the toolbar. 
 
To add a button to a toolbar, under Categories, highlight the toolbar you want to choose icons 
from. Click on a button then drag it to the desired toolbar. 
  

4. Click Close when done adding/removing buttons. 
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To reset a modified built-in toolbar: 

If you added or removed buttons to a built-in toolbar, here is how you can retrieve the original toolbar: 

1. Choose View, Toolbars, Customize. 

2. Click the Toolbars tab. 

3. Click the modified built-in toolbar. 

4. Click Reset. 

5. Click Close. 

Standard toolbar 

 

Icon Name Shorcut Function 

 

New Ctrl+N Create a new panel configuration 

 

Open Ctrl+O Open a panel configuration 

 

Save 
Ctrl+S 

  
Save the current panel configuration 

 

Print Ctrl+P Print the current panel configuration 

 

Delete Delete Delete the selected item from the panel 
configuration 

 

Apply Finish 
Code   Apply a finish code to the panel configuration 
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Icon Name Shorcut Function 

 

Refresh   Refresh the panel configuration 

 

About   Displays the software version 

Panel Width toolbar 

 

See View available widths. 

Create a panel configuration 
The procedure for creating configurations varies between manufacturers and even between catalogs for 
some manufacturers. The basic design flow remains the same. 

1. Launch Panel Builder. 

2. You can dock the Properties pane under the Content pane or auto-hide it. 

3. If the appropriate catalog is not yet selected, click on the drop-down arrow in the Content pane. 

4. Select the product from the Content pane and drag it to the into the configuration window on 
the right, where it snaps into place. 
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First, place the base frame, then any stacking frames, and finally apply any tiles. Note that 
nomenclature varies between manufacturers. This step might require that you place panels and 
then add elements to those panels. Panel Builder follows each manufacturer’s nomenclature. 
 
If you are configuring Knoll Dividends Horizon open position panel frames, you will be prompted 
to select structural options. For more information about 2020 Options, see 2020 Options help. 
 
As you put your panel configuration together, keep in mind that Panel Builder has many 
fundamental and catalog-specific rules set in place. Go to Configuration Design Rules for more 
information about this. 
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The caption bar at the top displays the total height of the stack assembly. 
 

 
 
If you want to remove a panel from the configuration, click on it then press . 

5. You can now set the properties/finishes (such as top cap type, power features, materials, etc.) 
of each element in the configuration. 

Note: When building a configuration in Panel Builder, if the tiles on one side are the same as the other, 

you can use the Copy Side buttons  to quickly duplicate the tiling. After copying tiles be sure to 
update the Finish Codes as required. 
 
Attention:  The copy side commands bypass the rules for tile placement. Use it only when you are 
certain that the configuration can support the same tiles on both sides. 

Set Panel or Frame Properties and Tile Finishes 

Once you have placed the elements (frame and tiles) in the Panel Configuration Pane, you may start 
assigning specific properties. 

1. Select the frame or tile in the Panel Configuration Pane. 
 
Note: If the panel configuration already has both panel frames and tiles in it, you would click 
one time to set the properties for the tile or else click a second time to select the properties for 
the frame instead. 
 
The manufacturer catalog you are working with determines the available Properties. 
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For example, two manufacturers may offer different widths of power and non power frames, 
and different types of finish fabrics for tiles. 

2. Click in the field to the right of the property name to make a different selection for the selected 
frame or tile. 
 

 
 
The new selection is displayed in the property field and the Panel Configuration changes as well. 

Note: Changing properties can change the part number of the frame or tile, or it may change its options 
and possibly add parts to the configuration. You simply have to select the properties. Panel Builder 
takes care of making the correct underlying changes. 



23 

Design rules 

2020 and the manufacturers have added many rules to prevent many illegal configurations. While these 
rules are extensive and well-tested, they are not a substitute for product knowledge. 

Ultimately the designer is responsible for building legal configurations. 

Both fundamental and catalog-specific construction rules are enforced (such as no stacking on top of 
10" element, total stack height restriction, etc.). If, for example, you place an element that exceeds that 
maximum panel configuration height, you will see an Alert dialog appear. If you do not wish to see this 
type of dialog, you can disable it through the View menu, Design Alerts. 

A fundamental Panel Builder rule is that tile elements must begin and end at tile seams. If a 7” high tile 
is placed at the bottom of Side 2, a Design Alert appears. This is because the base frame is defined with 
a 14” high tile seam. So a 14” high tile can be placed at the base, or as was done with the fabric tile on 
Side 1, another tile that aligns with another higher tile seam. 
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In addition to Design Alerts, Panel Builder sometimes displays a warning message when an element is 
placed. In the example below, a Markerboard tile has been added to the Side 1 stacking frame. This is a 
legal operation; however, since adding a tray to the markerboard tile would collide with the stacking 
seam, a warning message is displayed. Ignoring such messages will result in invalid configurations. 
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Some property changes reset the entire configuration. In the example below, changing the height of the 
base frame causes all the tiles and stacking frames to be removed. This assures that all element 
placement rules are run. 
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Apply finish codes to a panel 
configuration 
Like all elements, when you select a tile in the Layout Pane, the tile's properties display in the Properties 
Pane. One of the properties displayed is called a finish code. 

All elements have the Finish Code property. This is a free-form field into which you can enter any text. 
You can use the finish code to uniquely identify the selected element. 
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By default, the finish code maps to the Alias 1 field in 2020 Worksheet. If you would like this property to 
appear in a different Worksheet column, go to the Tools menu and select Options. 

There are two ways to apply finish codes: from the Properties pane and from the Apply Finish code 
dialog. 

From the Properties pane: 

1. Click on an element on the configuration side to which you would like to assign a finish code in 
the Panel Configuration window. 
 
If you have a panel configuration in the Panel Configuration Pane that already has both panel 
frames and tiles in it, you would click one time to set the finish code for the tile or click a second 
time to select the finish code for the frame. 

2. Place your cursor in the corresponding side’s Finish Code field in the Properties Pane and type 
the desired finish code. 
 
You can name your finish codes in whatever way will help you recognize how you want to 
specify that panel configuration’s finish once you bring the configuration over into a Worksheet 
file. 
 
The finish code is displayed on that side of the configuration over in the Panel Configuration 
Pane. 
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29 

From the Apply Finish code dialog: 

To quickly apply a finish code to the whole panel configuration: 

1. Click  on the Standard toolbar. 

2. Type in the finish code. 
 

 
3. Under Apply To, choose whether to apply the finish code to the selected panel only, to both 

sides of the panel configuration, to only side 1 or to only side 2. 

4. Click OK. 
 
Note: The finish code will be saved in the Property fields once you save the panel configuration. 



30 

Save the configuration 
Once the configuration is complete, you need to save it under a user-defined name and description in a 
Custom Catalog, much like a CAP Standard. The application creates all valid widths under that 
configuration name. It also performs cross-checks to ensure that the panel configuration is complete, 
and all style numbers are valid and available in the current electronic catalog. 

1. From the File menu select Save. 
 
If you would like to save your configuration to a custom catalog found in the network location, 
check Show All Projects. 

2. Select an existing Custom Catalog (.cc4 extension) or create a new one by clicking New. 
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3. Change the Panel name for the configuration. 
 
Note: Since the name appears as a tag on each occurrence of the panel configuration, we 
recommend entering a short name. For details, use the Description field which will appear in 
the Part Description column in Worksheet.  You should also use a simple naming convention 
including the product line abbreviation and the number of the panel configuration for that 
product line within that particular custom catalog, such as TST Panel 1 or TOS Panel 2. 
 
We do not suggest including the height of the panel as part of the configuration name, since 
you can change the height of the panel later on. Similarly, a name that describes the tiling will 
limit later editing of the configuration. 

4. Enter a Description, if you wish, that will appear in the Parts Description column in Worksheet. 
You can then edit configurations descriptions in Worksheets, but you should do so in Panel 
Builder for future insertions of a configuration in Worksheet. 

5. Click OK. 
 
Panel Builder automatically creates all valid widths of the panel configuration. When this 
process is complete, you will see the Save Panel Configuration window open. 

6. Click OK to close the Save Panel Configuration window. 
 
You can make this window close automatically by checking Automatically close when finished. 

To add this saved configuration to a drawing, see Add a panel configuration to the drawing. 

Warning:  Maintaining a good one-to-one catalog/drawing relationship is important. Keep this in mind 
as you save your configurations. Configurations in custom catalogs and their counterparts that have 
been inserted into drawings are forever linked. When you change a configuration and save it (to its 
custom catalog), as soon as a drawing with that configuration is opened and updated, all occurrences of 
that configuration are updated. If you use a configuration in more than one drawing, this will lead to 
undesired results. 
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The best practice is to establish a one-to-one relationship between a project and the custom catalog 
which contains its Panel Builder configurations. If you wish to reuse a configuration in a different 
project, open the configuration in Panel Builder and use the Save As command to save it into another 
custom catalog. This way, changing the configuration in one drawing will not impact it in the other. 
 
Since a one-to-one relationship should exist between the drawing and the custom catalog, an additional 
best practice is to keep the drawing and the custom catalog in the same folder. 

Add a panel configuration to a drawing 
 For each valid width of a stack assembly, the width is appended to the master configuration 

name. 

 The Master Configuration represents all valid widths. 

 The individual width configurations represent the actual elements which make up that 
particular width assembly. 

1. Open or return to your drawing. 

2. If you just saved a configuration in Panel Builder, it may not be listed in the Custom Catalog until 
you click the Refresh icon. 

 
3. From the Projects tab of the Explorer pane, select the size you want to use. 
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You can expand a width-specific configuration to see the components that are within the 
configuration without opening Panel Builder. 

4. Snap panel structures together using Node snapping points. 

Warning:  As for all CAP Parts, do NOT use AutoCAD Mirror on Panel Builder configurations. Do NOT 
explode Panel Builder configurations. 

Edit a panel configuration 
1. If you are in Panel Builder, click  on the Standard toolbar, select the desired panel 

configuration, and then click OK. 

If you are in CAP Designer, select a panel configuration in the drawing and then click  in the 
CAP Designer toolbar. 

2. Change the panel, frame or tiles properties as required. 

3. Select File, Save. This will update the Custom Catalog items. 

Note: To globally update the drawing, you must launch Panel Builder from CAP Designer. If you 
launched Panel Builder independently of CAP Designer, use Update Panel Configurations from the CAP 
Designer, CAP Panel Builder menu to update all panel configurations in the drawing. For details see 
Update panel configurations. 
 
If an edited configuration is used in other drawings, you must open each of those drawings and 
manually update the configurations. 
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Create a configuration from an existing 
one 
Use the Save As command to build new configurations out of an existing one. It works like Save, but 
allows a new configuration to be created without altering the original version. You can use a 
configuration as a template to quickly construct a similar but different configuration. 

1. Select a panel configuration in the drawing. 

2. Click  on the CAP Designer toolbar. Panel Builder opens the selected configuration. 

3. Edit/change the configuration for frames or tiles. 

4. From the File menu select Save As. 

5. Save the panel configuration in a Custom Catalog with a new configuration name. 

Note: Save As constructs a new panel configuration in a Custom Catalog, which can then be used in CAP 
Designer. Save not only saves a configuration, but also automatically updates all occurrences of that 
named configuration in the current drawing from which Panel Builder was launched. 

If you want to create a new empty configuration, simply click   on the Standard toolbar. 
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Change existing configurations in the 
drawing 
You can make changes quickly to a layout by replacing configurations in the drawing. You can apply the 
"master" configuration to any number of panel configurations already in the drawing. The appropriate 
width configuration will then replace the selected target configuration(s). This allows generic space 
planning, which you can then populate with finalized stack configurations. 

Note: If you know that you would eventually like to place a certain configuration in a drawing but that 
configuration has not been created yet, you can place a "blank" configuration in your drawing to serve 
as a placeholder for the configuration you will eventually create and bring into that drawing. You can do 
this by following the steps listed below. 

1. Place multiple configurations in the drawing. 

2. Create new configurations and save them to the Custom Catalog. 
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3. Select the Master Configuration and drag it into the drawing. 
 

 
4. From the Apply Panel Configuration dialog box click the Select Objects button. This will take 

you to your drawing where you can select the configurations you wish to replace. 

5. Press Enter and the Apply Panel Configuration dialog will return. 

6. Click OK. 
 
You will see the configurations you have selected change to the new configurations. If a new 
configuration is not valid for a selected configuration’s frame it is not replaced and the original 
configuration remains in place. 
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View available widths 
The Available Widths toolbar allows you to select a panel or door width to be used in configuration. 

 

You can select any width for building configurations. 

This is strictly a visual representation that Panel Builder uses to allow configurations to be built. 
When a configuration is saved, Panel Builder will automatically create all widths appropriate to 
the configuration type. 
 
Exceptions to this include when using Power Builder for Steelcase - Answer, and when setting a custom 
width or a field cut property. See Use Power Configurations - Steelcase Answer. 
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Print a configuration 
1. From the File menu, select Print Preview. Notice the name of the configuration at the top of the 

page. This can be a useful tool for installation documents. 
 

 
2. Use the buttons on top to go to the next page, go to the previous page, toggle between one and 

two page display, or zoom in or out. 

3. Click Print to print the configuration and Close to return to Panel Builder. 
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Find invalid or corrupted panel/power 
configurations 
The CAP Designer Check Panel/Power Configuration command scans the drawing and marks invalid or 
corrupted configurations. 

This function will check the following problems: 

 Problem #1: A panel or power configuration exists in the drawing, but it cannot be found in the 
custom catalog. 
 
In this situation, we recommend that you use the CAP Designer Configuration Manager dialog to 
rebuild the configurations to the custom catalog. 

 Problem #2: A panel configuration exists in the drawing but does not have the configuration 
data to rebuild the custom catalog. 
 
For every panel and power configuration used, the application stores a copy of the custom 
catalog data in the drawing. It uses this data to rebuild the custom catalog using the 
Configuration Manager dialog. If this information is missing, the application cannot rebuild the 
custom catalog. Panel and power configurations that refer to these non-existent data 
configurations are considered "corrupted." This typically occurs with a copy and paste between 
drawings, or by wblocking and inserting from one drawing to another. 
 
It is entirely possible to have a configuration that passes the Problem #1 check, but fails the 
Problem #2 check. In these cases, the configuration data is not "backed up" in the drawing. 
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If a configuration is corrupted, it will have the following characteristics: 

 Its configuration data is not in the drawing 

 It cannot be opened in Panel Builder 

 The Configuration Manager cannot rebuild it into a custom catalog 

 It could be counted in a Worksheet takeoff ONLY if its custom catalog is present and found 

To find invalid or corrupted panel/power configurations: 

1. From the CAP Designer menu, select CAP Panel Builder, Check Panel/Power Configuration. 

2. Click OK in the Scan Panel Configurations dialog to start scanning. 
 
Corrupted panel blocks will be marked with a yellow circle, while corrupted power blocks will be 
marked with a red circle. 
 
If the error circle says "Not Found," then it is Problem #1 listed above. If the error circle says 
"Corrupted," then it is Problem #2 listed above. 
 
If corrupted panel blocks are found, the best practice is to erase them from the drawing and 
replace them with a valid configuration. 

  



42 

Manage or rebuild configurations 
The Configuration Manager can help you: 

 Remove unused configurations from the drawing. 

 Reset properties for frames and tiles. 

 Rebuild configurations that exist in a drawing when the Custom Catalog for those configurations 
is not available. This would be required in these situations: 
 
- File sharing: You need to open a drawing containing the panel configurations on a computer 
other than the one on which you originally created the drawing, and you want access to those 
configurations in a Custom Catalog. 
- Data Recovery: A Custom Catalog containing the configurations has been inadvertently 
deleted. 

1. From the CAP Designer menu select Panel Builder, Configuration Manager. 
 
The Configuration Manager dialog box opens. All configurations that exist in the current 
drawing are listed, as well as the location of the Custom Catalog in which they are stored. For 
any configurations for which the Custom Catalog is not available the location indicates <Not 
Found>. 
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2. Click Purge Unused Configurations or Clear Default Properties. 

3. To rebuild a custom catalog, select all configurations listed as <Not Found> and click the Rebuild 
Custom Catalog button. 

4. In the Rebuild Custom Catalog dialog box, select an existing Custom Catalog in which to store 
the rebuilt configurations, or click the New button to create a new Custom Catalog. 
 
- Rebuilding to a new custom catalog rebuilds all valid configurations into the new catalog. 
 
- Rebuilding into an existing custom catalog redefines existing configurations in the catalog, 
defines any configurations in the drawing NOT in that custom catalog, and updates the links in 
the drawing to point to the rebuild custom catalog. 
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You will receive a warning informing you that rebuilding configurations to the existing custom 
catalog will corrupt those configurations in OTHER drawings which use the same existing 
custom catalog. If you do not want this to happen, click No and rebuild to a new custom catalog 
instead. Note that if you had a single custom catalog per drawing, this corruption will not be an 
issue. However, if other drawings use this configuration, you will have to rebuild the 
configuration in each of those drawings.  Click Yes if you want to continue. 

5. Click OK in the Rebuild Custom Catalog dialog. 
 
A Configuration Rebuild Progress dialog opens and displays the progress of configurations 
being rebuilt. 
 
When the process is complete, the Configuration Manager dialog returns. 

6. Click OK to close the Panel & Power Configuration Manager. 

Note: If you want to copy this drawing back to its original location, its configurations will be linked to 
the new custom catalog and not the original one. You must use the Configuration Manager again to 
rebuild the configurations in the original location. 
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Update panel configurations 
The best practice is to have a single custom catalog associated with a single drawing. However, 
sometimes you need to associate a custom catalog with a set of drawings, as is the case where the same 
project spans multiple floors and each floor is a different drawing. When this happens, it is possible to 
be in one drawing, make a change to a Panel Builder configuration, and then want that change to be 
reflected in all the other drawings in the project. 

When you edit and save an existing panel configuration, all occurrences of that configuration in the 
Custom Catalog and in the current drawing from which Panel Builder was launched are automatically 
updated. However, if the configuration is in other drawings, you must open each of those drawings and 
use the Update Panel Configurations command. 

1. From the CAP Designer menu, select CAP Panel Builder, Update Panel Configurations. 

2. Click OK when the Update Configuration dialog opens. 

Note: After a drawing's existing configurations have been automatically updated, it is possible that 
invalid configurations may now be placed on the existing frames. For example, the configuration for an 
18” wide panel in the drawing is changed to include a glass skin. Glass is not available in 18” width 
panels, therefore the updated configuration on the existing 18” panel is invalid. During the update 
process these invalid configuration assignments (also called "orphans") are detected and circled in 
yellow in the drawing. A tooltip is assigned to the circle which gives an explanation of the error for that 
specific instance. 
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Insert panel elevations in the drawing 
Once your drawing is complete, you will need to create elevation views of all the configurations so that 
installers can determine how to build them. Panel Builder has two types of elevations: dynamic and 
static. 

The best practice is to use static elevations, for the reasons outlined below: 

 Dynamic elevations are designed to support full height wall products. Instead of showing the 
front and back of each configuration, they show a view run of panels. In most drawings this 
would result in many more elevations, which is why they may not be the best practice for the 
product line that you are working with in Panel Builder. 

 Since they are dynamic, there is a link between them and the configurations associated with 
them. While this link means that, unlike static elevations, they do not have to be updated when 
configurations change, it also means that they cannot be exploded and manually edited to add 
more information to them. 

See: 

 Insert dynamic panel-run elevations 
 Insert static panel elevations 
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Insert dynamic panel-run elevations 

Note:  The manufacturer catalog you are working with determines the availability of this feature. The 
way panel run elevations are created is also manufacturer-specific. 

A dynamic panel-run elevation is logically "connected" to its plan-view parent so that if the parent 
configuration is modified, the elevation is also immediately modified to match the parent configuration. 
Linked elevations are a one-to-one relationship to their parent. Should the parent plan-view graphics of 
a linked elevation be erased, the elevation is also erased. 

1. Click the Automation Center icon in the CAP Designer toolbar. 
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2. Click Create Dynamic Panel-Run Elevations. 
 

 
3. In the Create Panel Elevations dialog box, give your panel elevation a name in the Label field. 

4. Click the Select Panels icon and select the panels for which you want an elevation. 

5. Click to select the elevation view location to be used for your elevation. (For example, if you 
would like to get an elevation for a panel on the inside of a configuration, click inside the panel 
structure.) 

6. Move the mouse toward the panel whose elevation you would like to capture and click. 
 
The Create Panel Elevations dialog window returns with the panel elevation displayed. 
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7. Click OK. 

 
The Create Panel Elevations dialog box closes and your panel elevation is attached to your 
mouse. 

8. Click at the location in your drawing where you would like to place your elevation. 

9. Rotate your elevation if necessary and click to set the elevation in place. 
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Insert static panel elevations 

Static elevations are designed to look like the Panel Builder configurations as seen in the Panel 
configuration pane. Installation drawings are easily created using the Draw Static Panel Elevations 
command. 

Note: As their name implies, static elevations do not change. If you edit a Panel Builder configuration, 
you will need to create a new static elevation for that configuration. Because they are static, they are 
simple AutoCAD blocks. If they need additional information, you can explode and manipulate them. 

1. From the CAP Designer menu, select CAP Panel Builder, Draw Panel Elevations. 
 
The Draw Panel Elevations dialog boc appears, listing the panel configurations used in the 
drawing. 

2. Click the Select All button or select the configurations you wish to have elevations for. 

3. Click Next. 

4. In the Appearance dialog box, you can change the layer and layer color that the elevations will 
be created on. Also select the layout you wish to have. 
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5. Click Finish. 

6. Pick a point on the drawing; the upper left hand corner of the elevation layout will be inserted 
here. 
 
The elevations are blocks and can be moved as needed. 
 
When you edit or change your configurations, the elevations will be updated in the drawing. 
However, if you change the elevations when the drawing is not open, the elevation will not be 
updated. Erase and reinsert the elevations into the drawing. 



52 

Best Practices 
Here are some best practices when working with Panel Builder: 

 As much as possible, maintain one custom catalog per drawing. 

 Keep the custom catalog and the drawing in the same folder. 

 When sharing within an office, keep the drawing and custom catalog in the same folder on the 
network, mapped the same on each user machine. 

 Do not use the AutoCAD Mirror, Explode or WBlock commands on Panel Builder configurations. 
Doing so will corrupt these configurations. 

 Use the Panel Builder Save As command to copy configurations between drawings. Do not use 
WBlock or cut and paste. 

 To maintain future flexibility when editing, give Panel Builder configurations short unique 
names. Do not include the height of the frame in the name. 

 Use the Configuration Manager to rebuild configurations when sharing with a remote office or 
notebook computer. 

 If you have multiple drawings sharing the same custom catalog, don't rebuild the custom 
catalog from one of the drawings. If you do so, each drawing will need to be rebuilt into its own 
unique custom catalog. 

 Use Static Elevations for large drawings with many occurrences of the same configurations. 
Reserve Dynamic elevations for complicated configurations where an entire run of panels needs 
a single elevation. 
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Command reference 
This section lists commands available through the various menus. All commands are already referenced 
by their respective tasks in this help file. The following topics give you a brief description of menus and 
commands and provide links to corresponding topics. 

 File menu 

 Edit menu 

 View menu 

 Tools menu 

 Help menu 

File menu 

Command Shortcut Description Help topic 

New Ctrl+N Create a new panel 
configuration 

Create a panel configuration 

Open Ctrl+O Open a panel 
configuration 

Open a configuration from Panel Builder 

Save Ctrl+S Save the current panel 
configuration 

Save the configuration 

Save As   Save the current panel 
configuration under a 
different name 

Create a configuration from an existing 
one 
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Command Shortcut Description Help topic 

Page 
Setup 

  Select the paper size, 
orientation, and margins 
for the configuration 
printout. 

  

Print 
Preview 

  Preview the current 
panel configuration 
before printing 

Print a configuration 

Print Ctrl+P Print the current panel 
configuration 

Print a configuration 

Exit   Close the 2020 CAP 
Panel Builder program. 

If an unsaved 
configuration is on the 
screen, the program will 
ask you to Save (Yes or 
No) or to Cancel the Exit 
command. 
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Edit menu 

Command Shortcut Description Help topic 

Delete Delete Remove the 
selected element 
from the 
configuration 

Create a panel configuration 

Copy Side 1 
to Side 2 
Available per 
manufacturer 

  Copy skins from 
side 1 to side 2. 

Create a panel configuration 

Copy Side 2 
to Side 1 
Available per 
manufacturer 

  Copy skins from 
side 2 to side 1. 

Create a panel configuration 

View menu 

Command Description Help topic 

Toolbars Show or hide toolbars, the Content Bar, or 
the Properties bar. Also, customize 
existing toolbars. 

Toolbars 

Design 
Alerts 

Enable or disable the display of an Alert 
dialog whenever you place an element 
that does not follow design rules. 

Design rules 

Status Bar Show or hide the Status bar.   

Refresh Redraw the panel configuration.   



56 

Tools menu 

Command Description Help topic 

Apply 
Finish Code 

Apply a user-defined finish 
code to the panel 
configuration. 

Apply a finish code 

Options Show the Max Height line on 
the Panel configuration pane. 

Select the 2020 Worksheet 
field that will store finish code 
or tag assigned in the 
Properties bar. 

  

Help menu 

Command Description 

Topics Open the 2020 CAP Panel Builder online help 
What's New Open the What's New window where you can read about and 

download software and manufacturer catalog updates. 
www.2020spaces.com Access updates online 
Diagnostics Troubleshoot and repair damaged files 
About CAP Studio Displays the 2020 CAP Panel Builder version number 
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